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Overview
The Assure DQ Release Notes describe the enhancements and modifications included in
Assure DQ 9.5. This document lists migration concerns, maintenance fixes that may affect
your rules if you upgrade from a previous release and known issues.
Follow the instructions in the Infogix Server Upgrade Guide to upgrade the Assure DQ
server to the new release. You must also upgrade any client installations to release 9.5.
Follow the instructions in the Assure DQ Client Installation Guide.

What’s New
This section summarizes the enhancements for Assure DQ Release 9.5.

Infogix Assure is now Assure DQ
As part of the Precisely rebranding strategy, Infogix Assure product is now rebranded as
Assure DQ. Within the user interface, users will see the new Assure DQ naming being used.
Note that there may still be some underlying references to "Infogix Assure", but those have
been kept to reduce any issues with the broader backend name dependencies.

Test Translation Rule
A rules developer can now test a translation rule. The rules developer can define one or more
tests including values for all translation inputs, run the test, and view the translation outputs
for all the tests performed. This allows the rules developer to quickly verify their translations
before using them in control point capture logic.

Improved Reference Reports
Reference and Referenced by reports are now shown in a flattened layout, without the use of
expand/collapse sections. This improves readability as well as printability.

Translation Usage Independent Caching
A rules developer can now specify the lifetime of a loaded translation table by specifying a
time of day at which the translation should be reloaded. Previously, translation data was
always discarded as soon as control points were no longer using the translation and reloaded
on the next use. Now, by specifying a time of day, the system can reuse translations across
control point executions at different times of the day, potentially improving control point
processing speed.

Work Field Increment
A new work field increment extract rule is added on the Extract tab for capturing control
points. This simplifies rule building for the rules developer who often needs to perform this
activity.

Detecting Control Point Executions Deletion During Import
When a controls export zip is loaded by the import process, the system will detect control
points that are being deleted which have execution history in the system and will warn the
user about those control entities that have this condition. The user can then get further
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information about the control points being deleted and how many executions will be deleted
by the import. The user must confirm that the executions will be deleted to complete the
import. This ensures the user performing the import understands the consequences of the
rules being imported, and why the import might take longer than normal.

Expanded Sublayout References
HTML, JSON and External Service layouts can now define sublayout elements that can parse
the data at a location according to another type of layout. For example, the text of a JSON
field might be parsed as a record of a positional layout. This gives the rules developer greater
flexibility in the definition and reuse of layout rules used for capture processing.

File Monitor from Archive File
A File Monitor capture source can now process an archive file that contains many files, and
obtain information about each file, or initiate separate control point processing for the
contained files. For example, a zip file of a folder containing many csv files can be processed
as a file monitor control point and trigger the capturing of each contained csv file in a
separate control point execution.

Control Data Export File Extension
Previously, the export control data utility always produced files ending with the extension
‘cdt’. Now, by default, the system will generate a file name that ends with csv if the field
delimiter used is a comma, or a file name that ends with tab if the field delimiter used is a
tab, or a file name that ends with cdt for anything else. The user can also specify the file
extension to use with the -ext option on the command line.

User Activity Tracking
The system now writes a user activity log file which logs the activity of logged in users
navigating throughout the system. Actions taken by users which are written to the audit
history such as saving, importing, or deleting rules are also written to the user activity log file.
Administrators can use this information for research or diagnostic purposes.

Customer Logo on Reports
Customers can configure the system to use their own logo on the reports produced by the
system.

Runtime Fields in Left/Right Include/Exclude
The rules developer can now specify an expression that includes runtime fields for a
reconciliation task side include/exclude when condition. This allows control points to be
defined that apply only to subsets of data specified at runtime.

Reconciliation Task Reports to Data360 DQ+
The system will now establish data stores in DQ+ for reconciliation task reports, including
child data stores for the left and right matching items. This allows data analysts in DQ+ to
perform additional analysis on the reconciliation task results produced by the control point.
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Fixed in this Release
The following issues have been fixed in this release of Assure DQ.

JIRA

Details

IA-51286

Reconciliation task validation check names were not
properly validated and could start with a digit.

IA-51289

Layout definition reports for external service layouts
(plugin layouts) were showing the actual value of any
password property but should only show “***”.

IA-51301

The control data results view popup was showing the
create time in the update time column.

IA-51313

The DQ Data Element Recap report showed an error when
opened.

IA-51363

On the Extract tab of a capture source, at the When
Layout level for an already existing when layout rule, the
layout picker could be opened when it should be been
disabled.

IA-51382

The exportControlData server utility, when encountering a
control entity specification that was not found, incorrectly
reported the error as a problem with a security profile.

IA-51396

When a controls developer chooses a translation rule and
only has view permission for the rule, an error “Failed to
match key ReportView” is displayed instead of the
definition report for the translation.
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Platform Improvements
This section summarizes changes to supported software, new features, and improvements for
this release.

New Software Supported
The following is now supported:
• WildFly 24.0.1
The complete list of supported software and hardware versions is included in the Technical
Specifications Document included in the application documentation.

Java Support
The product has been tested in the following Java environments:
•
•

Amazon Corretto 11 for WildFly 24
IBM SDK for IBM WebSphere

Library Updates
In this release, several third-party libraries were updated. These updates increase system
security and reliability. Several libraries were updated specifically to address security
vulnerabilities.

Fixed in this Platform Release
The following issues have been fixed in this release.
JIRA

Details

IP-5515

Fixed an issue where changes to a user’s group membership are
not becoming effective upon logging in to the application. This is
applicable for WildFly deployments only.

IP-5645, IP-5653

Updated log4j to a modified version of 1.2.17 that removes
classes for security vulnerabilities CVE-2019-17571, CVE-20214104, CVE-2022-23302, CVE-2022-23305 and CVE-2022-23307.
Note: This update may impact your logging if you have
customized cee.log4j.properties. See the Customized
cee.log4j.properties section in Release-Specific Considerations
for the release you are upgrading from.
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Changes to System Requirements
For current technical specifications, see the Web site:
http://www.infogix.com/resource/infogix-technical-specifications

Obtaining Product Updates
Be sure to check for product updates for the 9.5 release. Log on to
http://support.infogix.com and download any applicable fix packs or patches.

Release-Specific Considerations
The following sections contain information about migration considerations and maintenance
fixes that may affect rules migrated from versions 5.1 through 9.4. Refer to the section that
covers your current product version.

Upgrading from 9.4
The following consideration applies to upgrades from Infogix Assure 9.4.

Customized cee.log4j.properties
The new release of Assure DQ includes changes to the default log4j configuration file
(cee.log4j.properties), both adding a new appender for user activity logging, and changes to
the iitap appender (igx log) that remove a filter specification. If you use a customized
cee.log4j.properties in your CONFIG_OVERRIDE folder, be sure to copy the
components/kernel/conf/cee.log4j.properties to your CONFIG_OVERRIDE folder and reapply your customizations.

Oracle and SQL Database Drivers
Assure DQ 9.5 uses SQL Server JDBC Driver 8.2.0 or the Oracle 19.3.0.0.0 JDBC driver. Be
sure that your installation points to the correct driver.

Upgrading from 9.3
The following consideration applies to upgrades from Infogix Assure 9.3.

Customized cee.log4j.properties
The new release of Assure DQ includes changes to the default log4j configuration file
(cee.log4j.properties), both adding a new appender for user activity logging, and changes to
the iitap appender (igx log) that remove a filter specification. If you use a customized
cee.log4j.properties in your CONFIG_OVERRIDE folder, be sure to copy the
components/kernel/conf/cee.log4j.properties to your CONFIG_OVERRIDE folder and reapply your customizations.

SOAP and REST API Changes in ControlsAssureResultsService
In addition to the new listReports operation in ControlsAssureResultsService, the following
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inconsistencies were corrected in this service. These changes mean that your uses of
casapi_results.wsdl should be refreshed to ensure correct results with the service operations
readResultCatalogSummary and listResults.
•

ExceptionCatalogResponse attribute ID (returned as “id” in REST) is renamed to
catalogId.

•

ExceptionResponse attribute exceptionCatalogID is renamed to catalogId.

•

ExceptionResponse attributes reportID, ruleID and ruleTraceID have been removed
(values were never returned by earlier releases).

•

readCatalogSummary parameter “arg0” has been renamed to “catalogId”.

•

listResults parameters have been renamed: “arg0” is renamed to “catalogId”, “arg1” is
renamed to “offset” and “arg2” is renamed to “limit”.

Upgrading from 9.2
The following consideration applies to upgrades from Infogix Assure 9.2.

Customized cee.log4j.properties
The new release of Assure DQ includes changes to the default log4j configuration file
(cee.log4j.properties), both adding a new appender for user activity logging, and changes to
the iitap appender (igx log) that remove a filter specification. If you use a customized
cee.log4j.properties in your CONFIG_OVERRIDE folder, be sure to copy the
components/kernel/conf/cee.log4j.properties to your CONFIG_OVERRIDE folder and reapply your customizations.

Oracle and SQL Database Drivers
Assure DQ 9.5 uses SQL Server JDBC Driver 8.2.0 or the Oracle 19.3.0.0.0 JDBC driver. Be
sure that your installation points to the correct driver.

SOAP and REST API Changes in ControlsAssureResultsService
In addition to the new listReports operation in ControlsAssureResultsService, the following
inconsistencies were corrected in this service. These changes mean that your uses of
casapi_results.wsdl should be refreshed to ensure correct results with the service operations
readResultCatalogSummary and listResults.
•

ExceptionCatalogResponse attribute ID (returned as “id” in REST) is renamed to
catalogId.

•

ExceptionResponse attribute exceptionCatalogID is renamed to catalogId.

•

ExceptionResponse attributes reportID, ruleID and ruleTraceID have been removed
(values were never returned by earlier releases).

•

readCatalogSummary parameter “arg0” has been renamed to “catalogId”.

•

listResults parameters have been renamed: “arg0” is renamed to “catalogId”, “arg1” is
renamed to “offset” and “arg2” is renamed to “limit”.
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Known Issues
This section describes any known issues and provides corrective action, where applicable.

Test source error detection
The Test Source facility does not detect errors in On Begin processing for Capture sources.
The test appears to complete successfully with no input records read.

Extraction details
When you test a capture source, the extraction details show nested evaluate conditions up to
four levels deep. Beyond four levels, the source test extracts the information, but you cannot
see these levels in the test results.

Using multiple browser windows for Infogix applications
If you run more than one Infogix application, open a new Internet Explorer browser session
for each application. Use “New Session” from the File menu of Internet Explorer.
Web-based Infogix applications store application data on the server in the http session. If you
open a new tab or window from the File menu, the system shares session information across
these tabs or windows, which can result in unpredictable errors or data loss. The system
warns you if you attempt to do this, but it does not stop you.

Control data capture source with invalid order-by clause
A control data capture source, when changed from using a Detail control entity to using a
Match Data control entity, can fail with invalid column errors. If the original capture source
was defined with order by fields, when the rules writer changes the source to a match data
entity, the system hides the order by fields’ definition, but incorrectly retains the previously
defined order by fields in the rule. When the capture source is executed, the order by clause
is generated and likely leads to errors in the database. To correct the capture source, edit the
source. Temporarily, switch the source to use a Detail control entity on the Details tab. Switch
to the Select tab. The order by fields section appears again; remove all order by fields. Switch
back to the Details tab and choose the match data entity again. Switch to the Select tab and
verify the settings. Switch to the Extract tab and verify the extraction logic. Click OK and save.
Verify the order by information is successfully removed by viewing the definition report of the
control point.
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Contact Us
If you encounter any technical issues, we recommend that you visit the support portal
at support.infogix.com.
If your query has not been discussed previously, you can create a new topic and receive
answers from our product experts.
Alternatively, you can log a support ticket:
1. Select Sign in from the top right corner of the screen.
2. If you have already registered, enter your Email and Password, then click the Sign
in button. Or, if you are not a registered support portal user, click Sign up.
3. Once you have registered and signed in, select Submit a request from the top right
corner of the screen.
4. Complete all fields, then click Submit at the bottom of the screen.

Community
Our product is constantly evolving and input from you is highly valued. If you have any
suggestions, please contact the product team by submitting a feature request on
the Community.
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Notices
Trademarks
Infogix, the Infogix logo, ACR, ACR/Detail, ACR/Summary, ACR/Workbench, ACR/Connector,
Infogix Assure, Infogix Insight, ACR/Instream, ACR/File, Infogix ER, Infogix Perceive,
Data3Sixty, and Data360 are registered trademarks of Precisely. Data3Sixty Analyze,
Data3Sixty Govern, Data3Sixty DQ+, Data360 Analyze, Data360 Govern and Data360 DQ+ are
trademarks of Precisely. Any other trademarks or registered trademarks are the property of their
respective owners.
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